Color Video Digitizer
For Apple IIgs Computers

by Digital Vision, Inc.
COMPUTEREYES™

Color Video Digitizer

for the

Apple IIGS

OWNER'S MANUAL

Copyright 1989 by Digital Vision, Inc. All Rights Reserved.

ComputerEyes is a trademark of Digital Vision, Inc.
Apple is a registered trademark of Apple Computer, Inc.
Apple IIGS is a trademark of Apple Computer, Inc.
GS/OS is a trademark of Apple Computer, Inc.
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>1</td>
<td>Introduction</td>
</tr>
<tr>
<td></td>
<td></td>
<td>System Requirements</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Update Policy</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A Note On Copy Protection</td>
</tr>
<tr>
<td>6</td>
<td>2</td>
<td>Installation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Slot Assignment</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hardware Installation</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Computer Output and Monitor Input Connections</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Connection to the Video Source</td>
</tr>
<tr>
<td>12</td>
<td>3</td>
<td>Getting Started</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Make a Backup</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Quick-and-Dirty ComputerEyes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Booting Up</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The ComputerEyes Environment</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Configuration</td>
</tr>
<tr>
<td>17</td>
<td>4</td>
<td>Using ComputerEyes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Command Key Shortcuts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Apple Menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td>About ComputerEyes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Desk Accessories</td>
</tr>
<tr>
<td>20</td>
<td></td>
<td>File Menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td>New</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Open</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Open SPECIAL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Close</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Close All</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Save</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Save SPECIAL</td>
</tr>
<tr>
<td>29</td>
<td></td>
<td>Print</td>
</tr>
<tr>
<td>30</td>
<td></td>
<td>Quit</td>
</tr>
</tbody>
</table>
31 Image Menu
32  Capture Color
33  Capture B/W
33  Capture Settings...
37  View Full Image
38  View SPECIAL
41  View Video Input
42  Paint From Raw Data
43  Timer
44  Adjust Menu
44  Adjust Palette
46  High Contrast
47  Mirror
47  Invert
47  Scroll
48  Shrink/Expand
49  Configuration...
50  Window Menu

5  Hints and Techniques

51  Getting Good Color
52  The "Capture Settings" Options
54  Lighting and Related Considerations
54  Use of the "Adjust Palette" Controls
55  Resolution
57  Working With Video Tape Recorders
57  Using ComputerEyes Images In Other Programs

6  Theory of Operation

59  General Operation
60  ComputerEyes Hardware
60  ComputerEyes Software
61  ComputerEyes Raw Data File Format

7  In Case of Difficulty

8  Warranty Information
Congratulations on your purchase of the Color ComputerEyes Video Digitizer. We are confident that you will find it to be one of the most valuable and useful peripherals ever developed for the Apple II GS personal computer. The ability to inexpensively acquire real-world images from any standard video source—in full color or black and white—opens the door for many new applications for your computer.

This manual contains all the information you should need in order to make full use of the Color ComputerEyes system. The manual covers the installation and operation of the Color ComputerEyes hardware and software. We suggest that you read Sections 2 and 3 thoroughly before you go too far in order to avoid any possible confusion.

Color ComputerEyes is warranted to be free of manufacturing defects for a period of one year from the date of purchase. Please fill out and return the Owner Registration Form included with the system. This way, we can keep you informed of updates and enhancements as they become available.

Digital Vision considers you, our customers, to be a valuable resource. We encourage your suggestions and comments concerning any current products or ideas for future ones. Feedback of any type from our customers helps us maintain our high standards of quality and value. Please refer any correspondence to the address on the back cover of this manual.

Thank you for selecting this Digital Vision product. We trust that it will provide you with many years of outstanding service.
System Requirements

Color ComputerEyes is designed to run on an Apple II GS computer equipped with at least 768 kilobytes of memory total. This means that you must have an Apple II GS-compatible memory card with at least 512 kilobytes installed in the Memory Expansion Slot. A 768 kilobyte GS will allow you to have two active Windows open at one time; a 1.25 megabyte (or larger) GS will permit a maximum of eight open Windows (see the "Windows" discussion). You must have a 3.5" floppy disk drive. Any type of monitor will work; RGB monitors generally have better display quality, but mean that you can't use the "View Video Input" feature (see Section 3). An ImageWriter printer is optional if you want to print digitized images on paper.

Update Policy

It is our intent to constantly improve and add features to the Color ComputerEyes System Software as time goes on. At any time, you may update your Color ComputerEyes System Software to the current version at the nominal cost of $15.00 (plus $2.00 shipping) by returning your original disk to Digital Vision along with your payment. As long as you have returned your Warranty/Registration Card, you will be notified of significant updates to the Color ComputerEyes System Software periodically as they become available. Your suggestions for features that you would like to see included in the Color ComputerEyes System Software will be appreciated - just drop a note to the address on the back cover of this manual.

A Note On Copy Protection

The Color ComputerEyes System Software disk contains no form of copy protection. This is to allow you to easily make back-up copies of the software for your own use, to use the software from a hard disk, and to more readily build your own software around that provided, if you are so inclined. Our policy in this matter is for your benefit - please allow us to continue it by not giving out copies of this software to others.
The installation of Color ComputerEyes is a simple, straightforward procedure that takes only a few moments to perform. Installation consists of two parts: Installing the Color ComputerEyes interface board in your computer, and connecting your video source (and optionally your monitor and computer output) to Color ComputerEyes. These steps are described below.

**Slot Assignment**

Before you install the Color ComputerEyes board, you must decide which I/O Slot you will use. Color ComputerEyes can be installed in any vacant slot except, of course, the 60-pin Memory Expansion Slot. Choose a slot that is convenient for you, and note its number for future reference. The slots are numbered 1 through 7 from left to right. Depending on your system configuration, some slots are better choices than others.

You must tell your GS the slot where you're going to install the ComputerEyes card so that it isn't confused with another of your peripheral devices. You do this via the built-in "Control Panel". Refer to your GS Owner's Manual if you're not familiar with this. Some considerations for choosing a slot are listed below. You must change the "Slots" setting in the "Control Panel" for the slot you choose to the indicated value. Note that, after you change the "Slots" setting, you must re-boot the GS for the change to take effect.
Slot 1 - "Slots" = "Your Card". Works fine, but your serial printer (ImageWriter, for example) is disabled. Generally not a good choice.

Slot 2 - "Slots" = "Your Card". Works fine, but if you have a modem or other serial device connected to the Modern Port, it is disabled.

Slot 3 - "Slots" = "Built-in Text Display". A good choice, since ComputerEyes does not interfere with the operation of the Text Display. You must NOT set "Slots" to "Your Card" if ComputerEyes is installed in Slot 3.

Slot 4 - "Slots" = "Mouse Port". A good choice, since ComputerEyes does not interfere with the operation of the Mouse. You must NOT set "Slots" to "Your Card" if ComputerEyes is installed in Slot 4.

Slot 5 - "Slots" = "Your Card". Works fine, but if you have a 3.5" disk drive connected to the Smart Port, it is disabled.

Slot 6 - "Slots" = "Your Card". Works fine, but if you have a 5.25" disk drive connected to the Smart Port, it is disabled.

Slot 7 - "Slots" = "Your Card". A good choice.

**Important** - you MUST set the "Slots" assignment as indicated above for ComputerEyes to work properly.
Hardware Installation

The Color ComputerEyes Interface hardware consists of a single printed circuit board that contains the circuitry required to digitize video signals. This board is physically similar to others that you’ve installed in your Apple, so there’s nothing new for you to learn. Examine the board, and note the row of gold fingers along its bottom edge. You will insert this edge into one of the vacant peripheral I/O connectors on the Apple’s motherboard. The ComputerEyes board has three coaxial cables attached with RCA-type phono jacks and plugs at their ends. To perform the installation of the Color ComputerEyes interface board in the Apple, just follow the steps below:

1. TURN OFF THE POWER to the Apple.

2. Remove the cover to the Apple by pressing in the two tabs on the rear and lifting forward.

3. Choose an I/O slot for the Color ComputerEyes board from among the vacant slots available.

4. Touch the cover to the Apple’s Power Supply to discharge any static electricity that you may be carrying.

5. There is just one opening in the rear panel of the GS that is wide enough to accommodate the ComputerEyes cables. It is located directly above the Disk Drive connector. Remove the plug from this opening, if present.

6. Route the three Color ComputerEyes cables through the rear panel opening.

7. Hold the Color ComputerEyes interface board above the slot that you’ve chosen, with the components facing to the right.

8. Guide the board into the edge connector with a gentle back-and-forth motion, taking up the slack in the coaxial cables, and press down on the top edge to seat the board firmly.

---

Yes, there IS an opening through which the ComputerEyes cables will pass - see Step 5.
9. Replace the Apple's cover.

You may have noticed several adjustment controls (trimmer potentiometers) located on the Color ComputerEyes circuit board. These controls are preset at the factory, and should never be touched except by qualified repair personnel.

Computer Output and Monitor Input Connections

If you are using a composite monitor, either instead of or in addition to an RGB monitor, Color ComputerEyes gives you the capability of viewing the video input that you're about to digitize. This is done under software control, and lets you adjust your camera's aim and focus, or view your VCR's output, before capturing an image. You will find this feature very convenient. (Note: If you have only an RGB monitor, such as the Apple IIgs Color Monitor, that does not accept a composite video signal, you won't be able to use this feature; just skip the following paragraph.)

For composite monitors: Disconnect the cable between your Apple's Monitor Output jack and your monitor's input jack at both ends. Save the cable for use in the event that you should remove your Color ComputerEyes system. Now plug the Color ComputerEyes cable labeled "C" (for Computer) into the Apple's Monitor Output jack. Insert with a slight twisting motion. Likewise, plug the cable labeled "M" (for Monitor) into the monitor's input jack.

Connection to the Video Source

The final step is to connect your Color ComputerEyes board to your video source. This is done via the standard RCA-type Phono Jack labeled "V" (for "Video In") mounted on the end of the cable now extending out the rear panel of the computer. Since Color ComputerEyes is capable of acquiring images from a wide variety of sources, the following paragraphs are simply guidelines for making this connection.
Always connect your video source to ComputerEyes with the power off to both pieces of equipment. Otherwise, serious damage may result to either or both devices due to differences in grounding or static build-up.

Video Tape Recorders / Video Disk Players

These types of equipment are universally fitted with Video Output connectors of some type. By far, the most common connector is a RCA Phono Jack labeled “Video Out”. What you need is the coaxial Phono-Plug-to-Phono-Plug cable supplied with your Color ComputerEyes system. Connect this cable between your recorder/player’s Video Output connector and the Color ComputerEyes “V” input connector. Insert at both ends with a slight twisting motion.

Video Cameras for Video Tape Recorders

Video cameras that were purchased to operate with Video Tape Recorders usually have special cables that connect them to the recorder, since they often have power, audio, and remote control signals along with the video signal. The easiest way to interface to this type of camera is to connect it to the recorder as usual, and connect the recorder to Color ComputerEyes as discussed in the paragraph above. Alternatively, an adapter for your particular camera can be purchased where you bought the camera if the recorder must not be present. This adapter supplies power to the camera and makes the audio and video signals available on connectors. These are usually Phono Jacks, so that you can cable from the adapter to Color ComputerEyes with the Phono-Plug-to-Phono-Plug cable, as in the paragraph above.

Camcorders / Still-Image Video Cameras

Camcorders (Integrated video cameras and video tape recorders) and still-image video cameras (such as the Canon Xap-Shot) are excellent video sources. These vary somewhat from model to model in terms of the output connections available. Still, what you are looking for is the Video Out
connection. Some models have this as a standard RCA Phono Jack; others make Video Out available with a small adapter plug. Despite their differences, there is almost always a way to connect outputs of these types of devices to ComputerEyes.

Other Video Sources

Other types of video cameras, such as surveillance cameras, can be used as long as they put out standard composite video (that is, the same as Video Tape Players, Videodisks, etc.), or standard industrial (non-interlaced) video. Other video sources, such as a second computer, can also be used. For other video sources, special cables may have to be assembled or purchased if the output connector is not standard. Ask about them where you bought your equipment. Black-and-white cameras will give excellent results in all of the monochrome modes.

Many video sources have two types of outputs: "Video Out", and "Antenna Out" or "RF Out". Make sure that you always use the "Video Out" connection with ComputerEyes rather than the latter choice.
The Color ComputerEyes System Software is a friendly GS/OS-based environment that allows you to capture color and black-and-white images, view the last-acquired image, save images to and retrieve them from disk in various formats, make changes to images, and many other functions. It is all you really need in order to take full advantage of the system. Thus, Color ComputerEyes is ready to be used as soon as it’s unpacked and installed.

### Make a Backup

**BACK UP THE COMPUTEREYES SYSTEM SOFTWARE SOFTWARE DISK NOW!** Any one of the many available disk back-up utilities will work, or you can use the GS/OS Desktop to initialize a blank disk and then copy the Color ComputerEyes System Software disk to the new one by dragging the “ComputerEyes” disk icon on top of that of the blank disk. We highly recommend copying the Color ComputerEyes System Software disk and then storing it in a safe place, while using the copy (call it the "working copy") when working with Color ComputerEyes. The working copy must not be write-protected.

If you are using a hard disk, you can easily run Color ComputerEyes from it. First, create a folder (“New Folder” from the “File” Menu on the GS/OS Desktop) in a convenient, logical place on your hard disk, and give it a meaningful name (such as “ComputerEyes”). Then, using a file copy program or the Desktop, copy all of the files (except for the GS/OS System files and folders) from the Color ComputerEyes System Software disk to the new folder. Now, when we refer to your “working disk” in the discussions below, we’re referring to your new Color ComputerEyes folder.
Quick-and-Dirty ComputerEyes

If you’re an experienced user and simply can’t wait to see that first image, we’ll not make you read the whole manual first. But please remember that the manual is here and that even experienced users won’t be taking advantage of ComputerEyes’s many powerful features without reading it through at least once. That having been said, here are the quick-and-dirty steps to the first image:

1) Back up the ComputerEyes System Software disk
2) Bring up GS/OS
3) Using the ComputerEyes working copy, double-click on the “Eyes” icon
4) Complete the “Configuration” Dialog Box
5) Select “Capture B/W” or “Capture Color” from the “Image” Menu Bar item
6) Wait a few seconds and there you have it!

As long as you’ve installed ComputerEyes correctly and connected your video source properly, you should be staring at your first ComputerEyes image. It undoubtedly won’t be the best you’ll ever get, but it will be a good place to start. Now you can either read the rest of the manual or use it for reference as you explore the many features of ComputerEyes.

Booting Up

Before proceeding, make sure that the Color ComputerEyes interface card is installed in the Apple correctly, the GS Control Panel “Slots” setting is correct, the connections to the computer’s output and monitor’s input have been made (unless you’re using only an RGB monitor), you have cabled your video source to Color ComputerEyes, and your Color ComputerEyes System Software disk is backed up. Now “boot” your computer in the manner normal for your system. Usually, this means inserting the disk in Drive 1 and either cycling the Apple’s power switch or pressing CONTROL/OPEN-APPLE/RESET. When you reach the GS/OS Desktop, “launch” the Color ComputerEyes System Software by double-clicking on the “Eyes” icon on your working disk. The disk will spin for a few seconds and then you will see the first Color ComputerEyes dialog screen.

Note that the GS/OS System included on the ComputerEyes System Software disk does not necessarily contain all GS/OS features, since we wanted to leave room for a few example images. It does contain all of the
features necessary to run ComputerEyes. If there are other GS/OS features that you would like to use, you can always boot your own copy of GS/OS and then launch "Eyes" from the ComputerEyes working disk as described above.

The ComputerEyes Environment

The Color ComputerEyes operating environment is one that you will find quite convenient and even fun to use. It conforms to the Apple User Interface Guidelines, and should be quite familiar in appearance. If you have used any other GS/OS-based applications, you should have no trouble using ComputerEyes.

With very few exceptions (such as entering File Names for your images), ComputerEyes is entirely mouse-driven. Every action is initiated by selecting from Pull-Down Menus in the standard GS/OS fashion. You control much of the operation of ComputerEyes by specifying information in Dialog Boxes. If you are unfamiliar with how to do this, you can refer to the manual that came with GS/OS, although GS/OS is so friendly that learning its use can be picked up by most users with simple experimentation. If terms like "Double-Clicking", "Dialog Box", "Window", and "Dragging" are foreign to you, you may want to read the Apple documentation before proceeding. Otherwise, try moving around the Color ComputerEyes menu structure - you'll find it very friendly.

Configuration

If this is the first time you have run the Color ComputerEyes system, a "Configuration" Dialog Box will be presented. This allows you to specify information about various components of your particular system. If you don't see the "Configuration" Dialog as shown at the top of the next page the first time you run ComputerEyes, refer to the IN CASE OF DIFFICULTY Section later in this manual.

You will first be asked in which slot you've installed the Color ComputerEyes board. Type the Slot Number (don't press RETURN just yet). Next, you are asked whether you are using an RGB monitor (such as the GS Color Monitor) or a composite monitor. The "View Video Input" command only works with composite monitors (since your video input is, after all, a composite video signal). If you select the RGB monitor type, the "View Video Input" command will simply do nothing. If you are using both an RGB and
composite monitor, choose "Composite". Make the selection by clicking on the appropriate "Radio Button".

You can make changes to any of the items in the Dialog Box as many times as you would like by positioning the pointer on the item in the Dialog Box that you would like to change and clicking the mouse. When you are satisfied with the settings, click on the "OK" button or press the RETURN key. If the computer beeps and you get a Message Box with the message "Cannot Find Card at Slot #N" (where N is the Slot that you entered), you must first rectify the situation. Make sure that the Color ComputerEyes board is indeed installed in the Slot Number that you entered. Also check that you've set the "Slots" setting in the GS "Control Panel" to the correct value for the slot that you're using, as described in the INSTALLATION Section. If you can't find anything wrong with what you did, refer to the IN CASE OF DIFFICULTY Section.
The ComputerEyes board MUST be installed in the Slot Number that you entered. Also, the “Slot” setting in the GS “Control Panel” MUST be set correctly for ComputerEyes to work; the correct setting is not always “Your Card” - see INSTALLATION.

The system will then record the Color ComputerEyes Slot Number and your monitor type on disk (in a configuration data file called “CONFIG.DAT”) so that, thereafter, when you run ComputerEyes, you won’t have to go through the Configuration step. (Your working disk must not be write-protected.) If you make a mistake, or should you change something about your system that might affect the operation of Color ComputerEyes, you can enter the Configuration Dialog Box by selecting “Configuration…” from the “Adjust” Pull-Down Menu. Examples of this would occur whenever you move the interface board to a different slot, or if you were to use a different type of monitor.
After you've performed the configuration procedure (at least once), you will be presented with the Color ComputerEyes Desktop Screen. From here you can access all of the capabilities of the system. The Desktop Screen looks like this:

At the top is the "Menu Bar" that contains five items, which are the main categories of commands that control ComputerEyes. We also open up one empty "Window" called "Untitled1" in which you can work (more on Windows shortly). The order in which the five Menu Bar items are displayed from left to
right conforms to Apple standards (with the "Apple" and "File" commands on the left). They're not, however, necessarily in order of importance to us, but this is the order in which the topics will be discussed here. The remainder of this Section explains the operation of each of the functions available from the Menu Bar.

### Command Key Shortcuts

Many of the commands available throughout the ComputerEyes System Software can be executed more rapidly using a built-in set of Command Key Shortcuts. To use a Command Key Shortcut, you simply press a particular letter or number while holding down the OPEN-APPLE (or COMMAND) key. The Command Key Shortcut for each command (if it has one) is defined along with the command’s description in this Section. It is also displayed along with the command name in each Pull-Down Menu. For your convenience, the following is an alphabetical list of available Command Key Shortcuts:

- **A** - Adjust Palette
- **B** - Capture B/W
- **C** - Capture Color
- **D** - Close
- **I** - View Video Input
- **N** - New
- **O** - Open
- **P** - Print
- **Q** - Quit
- **S** - Save
- **T** - Timer
- **V** - View Full Image
- **W** - View Special

**A note on Windows:** Although we’ll be discussing the “Window” Menu Bar item last, it’s important to understand the very powerful implementation of windowing in the ComputerEyes System Software. Every image that you capture (or load from disk) is displayed in a Window, and there can be up to eight Windows active at any given time (two on a 768 kilobyte GS). Each Window is full-featured, in that it can be dragged around the screen, made smaller or larger, and supports scrolling. If you’re not completely familiar with how to control GS/OS Windows, you should read up and practice, because it is a very powerful feature that allows you to be working with several images on the Desktop at once. For example, you can capture different versions of the same image with various combinations of ComputerEyes “Capture Settings” or lighting conditions and compare them instantaneously to see what works the best. ComputerEyes Windows will be discussed in further detail near the end of this Section.

**A note on Graphics Modes:** The ComputerEyes System Software is designed to operate primarily in the GS Super Hi-Res 320 by 200 Graphics Mode. This
mode is the best for real-world images, as they can be displayed in up to 16 colors or shades of gray (instead of just 4 in the 640 by 200 mode). One of the powerful features of ComputerEyes is its ability to convert freely between Super Hi-Res 320, Super Hi-Res 640, Double Hi-Res, and Standard Hi-Res Graphics Modes. Since ComputerEyes supports up to eight active Windows, they must all be in the same Graphics Mode (a GS display limitation) and so, regardless of the ultimate use of an image, it is displayed as a ComputerEyes 320-mode Window. To view an image in any of the other supported Graphics Modes, use the "View SPECIAL..." command in the "Image" Menu.

With these notes in mind, we'll now proceed with the descriptions of the functions you can perform with the ComputerEyes System Software.

(Apple) Menu

If you pull down the colorful Apple in the upper left corner, you can select from the various options described below.

About ComputerEyes

If you select the "About ComputerEyes" option, you'll be presented with a Message Box that provides you with information about the software currently running, including the Version Number of the ComputerEyes program and copyright notice. Click on "OK" when you're done viewing the information to return to the ComputerEyes Desktop.

Desk Accessories

The remainder of the selections in the Apple Menu is a list of Desk Accessories currently installed. If you have booted directly from a copy of the ComputerEyes System Software disk, this list would contain just the Control Panel and the VideoMix Accessory (which supports the Apple Video Overlay Card). If you have booted from your own version of GS/OS, then the list would contain whatever Desk Accessories you may have installed in your System Folder.
The "File" Menu contains a set of commands that allow to access files on disk and perform related functions. These include loading images ("Open"), storing images ("Save"), closing Windows, printing images, and exiting the ComputerEyes application altogether. The "File" Menu will look like this:

<table>
<thead>
<tr>
<th>File</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>CN</td>
</tr>
<tr>
<td>Open</td>
<td>CO</td>
</tr>
<tr>
<td>Open SPECIAL</td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td>CD</td>
</tr>
<tr>
<td>Close All</td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>CS</td>
</tr>
<tr>
<td>Save SPECIAL</td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td>CP</td>
</tr>
<tr>
<td>Quit</td>
<td>CQ</td>
</tr>
</tbody>
</table>

The following paragraphs describe the commands listed in the "File" Menu.

**New (OPEN-APPLE/N)**

The "New" command allows you to open a new Window into which you can capture an image without disturbing the images in any other Windows you might have open. The new Window automatically becomes the active Window, and is given the name "UntitledN", where N is the number referring to the Nth open Window. For example, if you have two Windows open and you select the "New" command, the new Window is given the name "Untitled3". Whenever you save an image to disk, the name of the Window becomes the name you specify for the Image file.

The position of the new Window on the screen is arbitrarily set slightly down and to the right from the original position of the previously opened Window; you can, of course, drag and resize the Window with respect to
other Windows as you see fit. You are allowed two open Windows on a
768 kilobyte GS and eight Windows on a 1.25 megabyte (or greater) GS;
if you try to open a new Window without enough memory, you'll get an
error message to that effect. These considerations also apply to the
OPEN commands described below.

Open (OPEN-APPLE/O)

The "Open" function allows you to retrieve images saved previously for
you to view. It also allows you to load images generated by other
programs, as long as they were saved in the Apple standard "Screen"
format (many paint programs can save images as "Screens").

When you select "Open", you are presented with a standard GS/OS disk
access Dialog Box, such as the example shown below. Here, you can
scroll through a list of available image files, change disk drives or sub-
directories ("Folders"), cancel the operation, or choose an image to load.
To do so, click on the desired image file name to highlight it and click on
"Open", or double-click on the desired image file name. If you're not
familiar with this type of Dialog Box, refer to your GS/OS documentation.

![Choose a file to load: COMPUTEREYES ASTRONAUT BARN VEILED.WOMAN CLOWN](image)

When you've selected an image file to open, ComputerEyes automati-
cally creates a new Window with its name and proceeds to load the image
into it. This becomes the active Window. If ComputerEyes experiences
a problem reading the selected image file, you will, of course, receive an error message to this effect.

Images loaded from disk with the "Open" command can be manipulated with any of the many available ComputerEyes Image enhancement commands (see the discussion of the "Adjust" Menu).

Open SPECIAL

The "Open SPECIAL" command allows you to load images other than those saved in the standard "Screen" format. The operation of the command is exactly the same as that of the "Open" command (see above), with the exception that ALL file types (not just "Screen" image files) are displayed in the list of available files to load.

The "Open SPECIAL" command is intelligent in that it automatically determines the Graphics Mode and file format of the image that you're loading (including images saved using the "Save SPECIAL" command - see below). When it determines the type of image file you've selected, it displays a Message Box on the screen telling you what file type is being converted. Click on "OK", and then the image is automatically converted to the GS Super Hi-Res 320 by 200 Graphics Mode and placed in a new Window. Refer to the discussion of the "Save SPECIAL" command below for a complete description of the image file types supported. If you try to load a file which is not an image in one of the supported formats, you'll receive a "Cannot Load File" error message.

A few notes are in order concerning a few of the SPECIAL file types that can be loaded. For more detail on the various Graphics Modes, refer to the "View SPECIAL" discussion.

Raw Data - One of the file formats that can be loaded is the ComputerEyes Raw Data format. The importance of Raw Data files should not be overlooked. When you use them to store your images, you can build a collection of images that are completely independent of the particular Graphics Mode that happened to be in use at the time the image is saved. Also, raw images from your collection can be loaded into ComputerEyes and converted, for example, to Standard Hi-Res files at a later date, even though acquiring Standard Hi-Res files wasn't your original intent. To pay for all of this flexibility, remember that Raw Data files are rather large (192K), take a little while to save and load, and aren't directly compatible with other software. Because of the powerful new features of the GS/OS version of the ComputerEyes software, Raw Data files created with earlier versions (before Version 3.0) are not compatible; if you have Raw
Data files created with an earlier version, convert them to Super HI-Res Screen files using the earlier version for use with the new software.

Standard and Double HI-Res files - Because the Super HI-Res mode has better resolution and color rendition than the other two modes, these translations are essentially perfect. They do, however, assume that the original image is considered to be black-and-white, with the exception of Double HI-Res images actually saved by ComputerEyes, in which case the mode (color or black-and-white) is retained. Because Super HI-Res images have slightly greater dimensions than the other two types, the converted image ends up placed in the center of the Super HI-Res screen, with the outer edge appearing black. Also, because of the resolution differences, the aspect ratio is slightly distorted. Both of these characteristics can be compensated for using the "Adjust" commands (see below).

Print Shop Graphic - The Print Shop Graphic is blown up into the same size area as that used in the Graphic Editor section of Print Shop. Note that you must actually save a Graphic to your own disk from Print Shop in order to load it into ComputerEyes; that is, ComputerEyes can not directly read the Print Shop Graphics disks.

Close (OPEN-APPLE/D)

Whereas the "New" and "Open" commands result in new Windows being opened, the "Close" command performs the opposite function: the currently active Window is closed, and any image that might be residing in it at the time disappears. Thus, if you have an image that you want to save for later use, you should save it to disk (see the "Save" and "Save SPECIAL" commands below) before closing its Window. The reasons for closing a Window would be to make room on the Desktop for a new image to be captured or loaded if you already have the maximum number of Windows open, or simply to clean up the Desktop.

Close All

The "Close All" command is similar to "Close" (see above) except that it closes ALL open Windows. Its purpose is to completely clean up the Desktop so that you can start with a clean slate.
The "Save" function allows you to store images that you have acquired using Color ComputerEyes as standard Super Hi-Res screen image files on disk. These files may then be recalled for viewing at a later date (see "Open" above) or used by other programs for further processing, printing, etc.

When you select "Save", you are presented with a standard GS/OS disk access Dialog Box, such as the example shown below. Here, you can specify the name for the image you would like saved by typing any valid GS/OS file name in the "Save picture as:" box. You can also change disk drives or subdirectories ("Folders") or cancel the operation. When you're ready, click on "Save" and ComputerEyes will save your image to the disk and folder currently specified. If ComputerEyes experiences a problem saving the image file, you will, of course, receive an error message to this effect. If you're not familiar with this type of Dialog Box, refer to your GS/OS documentation.

It is important to note that, when you use the "Save" command, you are always saving the image in the currently active Window. Also, the entire screen of which the Window is just a view is saved, not just the portion that is currently inside the Window boundaries. The name that you specify in the "Save picture as:" box thereafter becomes the name of that Window.
The "Save" command always saves the image in the active Window as a standard Apple Super Hi-Res 320 by 200 16-color screen. This is the screen file format as defined by Apple Computer and used by the majority of GS graphics and paint programs. Therefore, your ComputerEyes images can be used with any other software conforming to this standard, such as Paintworks from Activision, Deluxe Paint from Electronic Arts, and 816/Paint from Baudville. The images each require 65 blocks of disk storage space. If you would like to save images in a different format, use the "Save SPECIAL" command described below. Refer to the "Using ComputerEyes Images In Other Programs" discussion in the HINTS AND TECHNIQUES Section for related information.

### Save SPECIAL

A unique feature of ComputerEyes is its ability to save and load images in a variety of different Graphics Modes and file formats. Although images are always displayed on the ComputerEyes screen in the Apple Super Hi-Res 320 by 200 16-color mode, they can be saved to disk in any of the formats described below. For example, Color ComputerEyes can be used to capture images for use with Dazzle Draw running on a friend's Apple IIE. If you would like to view an image that you have in a Window in one or more of the different formats supported, use the "View SPECIAL" command found in the "Image" Menu.

When you select the "Save SPECIAL" command, you are first presented with a Dialog Box from which you can select the format you would like to use, as shown at the top of the following page. To do this, click on the Radio Button associated with the desired format. Clicking on "Cancel" gets you back to the ComputerEyes Desktop.

Note that the "Raw Data" selection will only be enabled if the active Window has raw image data associated with it. This will be the case if the Window contains the last image captured with ComputerEyes or the last image loaded as "Raw Data" using the "Open SPECIAL" command, either of which result in raw image data being available to be saved.

There is a "Dazzle Draw Format" Check Box at the bottom of the "Save SPECIAL" Dialog. Refer to the discussion of the Double Hi-Res file types below for its meaning. There is also a "Paint From Raw Data" Check Box; refer to the discussion of the Super Hi-Res (640 B/W) file type for its meaning.

After you select the format, click on "OK". You'll then be presented with a standard GS/OS disk access Dialog Box identical to that used in the
Save Image As:

- Super Hi-Res (640 B/W)
- Double Hi-Res (Color)
- Double Hi-Res (B/W)
- Standard Hi-Res
- Print Shop Graphic
- Raw Data

☐ Paint From Raw Data

☐ Dazzle Draw Format

"Save" command described above. Here, you can specify the name for the image you would like saved by typing any valid GS/OS file name in the "Save picture as:" box. You can also change disk drives or subdirectories ("Folders") or cancel the operation. When you’re ready, click on "Save" and ComputerEyes will automatically convert the image to the format that you specified earlier (which you can view on the screen), and then save your image to the disk and folder currently specified. If ComputerEyes experiences a problem saving the image file, you will, of course, receive an error message to this effect. If you’re not familiar with this type of Dialog Box, refer to your GS/OS documentation.

The various Graphics Modes supported by Color ComputerEyes are described below. Again, if you would like to see what your image looks like in any of these formats, use the "View SPECIAL" command first. Refer to the discussion of the "View SPECIAL" command for more details on the characteristics of each of the particular Graphics Modes.

Super Hi-Res (640 B/W) - The image in the active Window is converted to the less popular Super Hi-Res 640 by 200 4-color Graphics Mode. Since only four colors are available, we use this as a black-and-white mode only. AppleWorks GS and some desktop publishing programs use this mode. These image files require 65 blocks of disk space.

Note that, if Raw Data is currently available and you select the Super Hi-Res (640 B/W) file type, the "Paint From Raw Data" Check Box will be enabled. If you click on this box to place an "X" in it, ComputerEyes will
actually paint the screen in 640 mode directly from the raw image data, rather than convert the screen from the 320 mode image. This results in an image of higher quality (especially if "Dithering" is turned on - see the "Capture Settings" description in the "Image" Menu), and should generally be used for applications requiring 640 mode black-and-white images.

Double Hi-Res (Color) - The image in the active Window is converted to the Double Hi-Res 140 by 192 16-color Graphics Mode.

Double Hi-Res (B/W) - The image in the active Window is converted to the Double Hi-Res 560 by 192 black-and-white Graphics Mode.

Note that, at the bottom of the "Save SPECIAL" format selection Dialog Box, there is a Check Box item called "Dazzle Draw Format". This item will be enabled if you select either Double Hi-Res Graphics Mode. There are two file types in use for Double Hi-Res images: the Dazzle Draw format and the two-file format. If you click on the Check Box to place an "X" there, the Dazzle Draw format will be used; otherwise the two-file format will be used. These are described below:

Dazzle Draw format - Dazzle Draw, by Broderbund, is a popular Double Hi-Res graphics manipulation program, and uses its own particular file format. It is a single file consisting of the "Auxiliary Memory" data followed by the "Main Memory" data. Images saved with this option can be loaded directly into Dazzle Draw for further processing. Other programs, such as "Publish It!" by Timeworks, also use this format. Note that you can convert images from other programs to Dazzle Draw format (or vice-versa) using the Color ComputerEyes software. Dazzle Draw image files require 33 blocks of disk space.

Two-file format - ComputerEyes will save the "Main Memory" portion in the file name that you specify, plus the "Auxiliary Memory" portion in a file of the same name with the extension ".AUX". For example, if you name your image "HOUSE", it will be saved as the two files "HOUSE" and "HOUSE.AUX". This is the format used by many Double Hi-Res graphics programs, such as Beagle Graphics and Triple Dump from Beagle Brothers. Each of the two files requires 17 blocks of disk space (34 blocks total).

Standard Hi-Res - The image in the active Window is converted to the Standard Hi-Res 280 by 192 black-and-white Graphics Mode. This is the Apple Standard Hi-Res image format. The entire 8 kilobyte Hi-Res graphics area is stored as a binary file, occupying exactly 17 blocks. This
is the format that most other Standard Hi-Res image handling programs will accept.

Print Shop Graphic - This is the file format used by the GS version of Print Shop by Broderbund for "Graphics", the images used in Greeting Cards, Letterheads, etc. "Graphics" have a modest resolution of 88 by 52, with just 8 fixed colors. But since they are usually printed rather small, some surprisingly good results can be obtained. Only the GS version of Print Shop Graphics is supported. The original Super Hi-Res image is first blocked up into the same size pixels as in the "Graphic Editor" portion of Print Shop. Then each of these pixels is assigned one of the eight Print Shop colors closest to the original Super Hi-Res image color. Dithering is always applied to this process to help the Graphic appear as good as possible. Finally, a box is drawn on the screen with a size equal to the size of the entire graphic in the Print Shop Graphic Editor. You can then move this box around the screen using the Arrow Keys to select the portion of the screen that you want to save. When you're done, click the Mouse Button or press any key. Then the portion of the image that you selected with the box will be saved as a Print Shop Graphic that can be used with your GS Print Shop program. Super Hi-Res images have resolution and color rendition that are far superior to Print Shop Graphics, so you may be a bit disappointed at first, but stick with it - Print Shop Graphics always look better printed than they do blown up on the screen. Try to keep images as simple as possible if you are going to convert them to Print Shop Graphics.

Raw Data - This is a file format unique to Computer Eyes in which all 192 kilobytes of raw image data captured when an image is scanned can be saved to disk. There are two reasons for doing this: First, if you load a Raw Data file back into Computer Eyes, it is just as if it were freshly captured; that is, you can repaint the screen in different Graphics Modes and make various changes, and always be able to get back to the original image (see the HINTS AND TECHNIQUES Section). And second, other application programs could be written that would take advantage of the fact that there is much more image data available than can be displayed on the GS graphics screen. Computer Eyes also saves all of the "Capture Settings" along with the raw image data (except "Palette" and "Auto Calibrate"), so that when you load the image back into Computer Eyes, the screen is repainted exactly the way it was when the image was saved. The format of the Computer Eyes Raw Data file is described in the THEORY OF OPERATION Section.
If you own an Apple ImageWriter printer, you can obtain high-quality full-page printouts of your ComputerEyes images directly from the ComputerEyes software. You are first given a “Print To ImageWriter Options” Dialog Box, with three choices asking you how you would like the image printed, as shown below. To print a color image, you must have a four-color ribbon installed in your ImageWriter II. The “From Screen” options mean that the color or intensity level of every screen pixel is mapped to the printer. This means that you can load images from other programs and print them using ComputerEyes. The “Color From Raw Data” option bypasses the screen and uses instead the original Red, Green, and Blue image data acquired when an image is captured. This approach is not limited to the sixteen available screen colors, and can result in printed images with smoother color variations. The “Color From Raw Data” option is disabled if there is no raw image data associated with the currently active Window.

Make your choice by clicking on the appropriate Radio Button, or click on “Cancel” to change your mind. Once you have selected the Print Style, click on “OK” to begin printing. The image in the active Window will then be printed. You can press the ESCape key at any time while the image is printing to cancel the operation.

If you're having difficulty getting your images to print correctly, take a look at your GS Control Panel Printer Port settings. ComputerEyes will print
properly using the default setting for all of the parameters, with the exception of “XON/XOFF Handshake”, which should be set to “Yes”.

You may find that, depending on several factors including the age of the printer ribbon, you may want to make adjustments to an image before you print it. That is, a perfect image on the screen doesn’t always result in a perfect image when it is printed. It’s often the case that increasing the contrast and sometimes the brightness with the “Adjust Palette” command before printing results in superior printed images.

Please note that we’ve provided the printing capability as a convenience to ImageWriter owners. If you have a different printer, we can only say “sorry” - we’re really not in the printer screen dump software business. You can, of course, print your images using another graphics program that supports your printer/interface combination.

**Quit (OPEN-APPLE/Q)**

You can exit from Color Computer Eyes by selecting “Quit” from the “File” Menu. If there are any active Windows that have not been saved to disk, it is your responsibility to do so before quitting if you want to save any of them. Color Computer Eyes first closes all open Windows and then uses the standard GS/OS exit path, which means that you’ll return to the GS/OS Desktop, from which you can launch into the next application or perform whatever other tasks you deem appropriate.
This collection of commands are really the heart of ComputerEyes. They allow you to capture images into screen Windows, view them as full-screen images, view them in various Graphics Modes, and preview the input video signal. The "Image" Menu is shown below, and the commands that it contains are described in the following paragraphs.

The "Capture" commands are the heart of the ComputerEyes system. They cause the video signal present at the Video Input connector of ComputerEyes to be scanned and displayed in the currently active Window on the GS's monitor. While the image is being scanned, a message to that effect is displayed on the screen. When the scan is complete, a short beep will be heard (this lets a live subject know that it's alright to move). The Window is then painted with the image that you've captured. The image will continue to be displayed for you to view in the active Window until you either "Close" the Window or capture another image into it.

There are two "Capture" commands: "Color" and "B/W" (black-and-white). These commands are described below, but first an important point must be made:

One of the powerful features of your ComputerEyes system is that it allows you to capture an image and then experiment with its appearance as many times as you would like, without ever losing the original captured image data. Specifically, the "Capture" commands cause 192 kilobytes of "Raw Data" to
be acquired. Then, according to the "Capture Settings" (see the "Image" Menu), the Raw Data is analyzed and the Super Hi-Res screen is painted. You can change any of these settings as many times as you'd wish to get the effect that you're after, without having to capture another image each time. This approach makes it easy to get exactly the style of image that you want.

Once you've captured an image, the Raw Data stays available for use by all of the image adjustment commands. It only disappears if it's replaced when you capture another image, or when you load a "Raw Data" image type from disk (see the "Open SPECIAL" command). You can even save all of the Raw Data to disk as a file if you wish (see "Save SPECIAL"); when you do this, you can at any later time load the Raw Data back into ComputerEyes and continue to make changes to the image, just as if it had been freshly captured.

Capture Color (OPEN-APPLE/C)

This command causes ComputerEyes to capture a color image in the GS's Super Hi-Res Graphics Mode. Images have a resolution of 320 pixels horizontally by 200 pixels vertically. In this mode, up to sixteen colors can be displayed on the screen, out of the 4096 colors that make up the GS's total color repertoire. The ComputerEyes software uses a sophisticated voting technique to determine which sixteen colors to use to display your image. These sixteen colors are called the "palette".

When you capture a color image, after the scan period the system takes another few seconds to analyze the image to determine the color palette it will use to paint the image. It displays a message on the screen to this effect, and then paints the image into the active Window. It's important to note that, regardless of the size of the Window, ComputerEyes always keeps a full-screen representation of every image on hand. You can scroll a Window around to view various portions of an image, or you can use the "View Full Image" command (see below) to see the entire image all at once.

When capturing a color image, ComputerEyes chooses initial settings of brightness, contrast, and color content that will result in generally realistic images. If your first image isn't quite up to your expectations, don't despair - you'll have ample opportunity to change its characteristics using the powerful "Adjust" commands described later on.
Capture B/W (OPEN-APPLE/B)

This command is similar to "Capture Color", but causes ComputerEyes to capture a black-and-white image in the GS's Super Hi-Res 320 by 200 Graphics Mode. The palette is pre-defined to be shades of gray. When you capture a black-and-white image, ComputerEyes actually disables the color decoding circuitry on the interface card to produce sharper black-and-white images.

If, when you attempt to capture an image, you get a "No Video Signal Detected" error message, you must first remedy the situation. This message means that the ComputerEyes board can't "see" a legitimate video signal at its Video input connector. Check your cable connections, make sure that your video source is powered, or refer to the IN CASE OF DIFFICULTY Section.

If you are having difficulty obtaining an image, you can refer to the IN CASE OF DIFFICULTY Section to determine the cause. The problem is probably quite simple, as ComputerEyes was designed to be as easy to use as possible.

Capture Settings...

The "Capture Settings" command controls a powerful set of functions that affect characteristics of the way images are actually captured. They greatly enhance the flexibility and capabilities of your Color ComputerEyes system. There is a very important difference between "Capture Settings" and the "Adjust" commands discussed below. This is that these settings have an effect only on images either captured or re-displayed using the "Paint From Raw Data" command after a change has been made to them. They have no other affect on images already captured, and have no affect at all on images loaded from disk, with the exception of Raw Data files. On the other hand, all of the other "Adjust" commands affect the appearance of images that exist in Windows, and have no affect on subsequent Captures.

When you select "Capture Settings", you are presented with a Dialog Box that contains entries for all of the various options, as shown below. There are four Check Boxes that control settings that have just two states, and two boxes where you may enter numerical values. The function of the various Capture Settings are described in the following paragraphs. After you have made the changes that you would like, click on "OK" and
the settings will be recorded for use in subsequent Captures or if you
"Paint From Raw Data". If you click on "Cancel", any changes you may
have made will be ignored. In either case, you'll return to the Comput-
erEyes Desktop.

Capture Settings:

- Dithering  
  On

- Palette  
  Unfrozen

- Capture Speed  
  Normal

- Auto Calibrate  
  On

No. Colors/Levels: [16]  
Color Separation: [2]

OK  
Cancel

All of the ComputerEyes Capture Settings (except "Auto Calibrate") are
saved in the configuration file CONFIG.DAT whenever you exit Comput-
erEyes, so that they become the defaults the next time you run the
system. This feature is provided for your convenience, and means that,
if you usually capture images with the same settings, you don't have to
change them each time you run ComputerEyes. "Auto Calibrate" is
always set to "On" each time you run ComputerEyes, since there would
otherwise be no calibration data available the first time that you captured
an image, as explained below.

Dithering

An option is provided to allow you to display images using dithering.
"Dithering" is a technique whereby the effect of additional colors or
intensities is achieved by displaying the separate available colors or
intensities in an alternating pattern. The resulting images can have a
smoother, more pleasing appearance. With "Dithering" off, images are
displayed with up to 16 colors or gray levels. With "Dithering" on, the
same colors or gray levels are used to display the image, but shades that
lie between two colors or gray levels are represented by dithering
between them; hence, the smoothing effect.
To turn "Dithering" off when it's currently on, or vice-versa, simply click on the appropriate Check Box. That is, clicking on "Dithering" toggles its setting. The current setting is always displayed beneath the Check Box. The default setting for "Dithering" is "On", since this generally results in more desirable images.

If you have raw image data available, as when you have freshly captured an image or loaded a Raw Data file, and you select the "Paint From Raw Data" command, this will cause the screen to be repainted using the "Dithering" option that you specified. You can capture an image, display it, change the "No. Colors/Levels", "Color Separation", and/or "Dithering" options, and redisplay the image using the "Paint From Raw Data" command any number of times without affecting the raw image data. This is another means that is provided for manipulating images that you capture as much as you would like on an off-line basis.

Palette

Also provided is the ability to freeze the Super Hi-Res color palette to the one currently in use. Normally, you would not want to do this, to give you the greatest number of colors or gray levels to represent various different images. There are some cases, however, where you might want to have several images using exactly the same palette. For example, an animation program might require you to cycle between several images with identical palettes. As another example, you might have captured an image of a person's face and gotten a palette containing a perfect set of facial tones, which you can freeze so that they can be used in capturing other people.

The two settings of "Palette" are "Frozen" and "Unfrozen". To change the current setting, simply click on the appropriate Check Box. That is, clicking on "Palette" toggles its setting. The current setting is always displayed beneath the Check Box. The default setting for "Palette" is "Unfrozen". After you freeze the palette, any time you subsequently capture an image or load a Raw Data file from disk, the current palette will be used.

Capture Speed

Normally, ComputerEyes requires 5 seconds to capture images. However, if you wish, you can choose a slower scan speed (12 seconds) to produce images with somewhat better resolution. The reason for this is rather technical, and has to do with the interface characteristics of composite video signals. Essentially, you're given the choice of trading off capture time against a certain improvement in image quality. This improvement can be most readily noticed as somewhat less jaggedness.
along lines in images that are close to horizontal.

To change the "Capture Speed" setting, simply click on the appropriate Check Box. That is, clicking on "Capture Speed" toggles its setting. The current setting is always displayed beneath the Check Box. The default setting for "Capture Speed" is "Normal".

Auto Calibrate

Normally, every time ComputerEyes captures an image, it automatically calibrates the settings of intensity (Brightness and Contrast) and color (Red, Green, and Blue) settings to values that will give generally a realistic color balance. Thus, the default setting for "Auto Calibrate" is "On". However, in certain situations, you might not want to allow ComputerEyes to calibrate each time you capture, and so you could set "Auto Calibrate" to "Off". An example of this would be if you were collecting a series of images of people's faces, and you wanted the background to always be similar even though the people themselves varied.

To turn "Auto Calibrate" off when it's currently on, or vice versa, simply click on the appropriate Check Box. That is, clicking on "Auto Calibrate" toggles its setting. The current setting is always displayed beneath the Check Box.

Please note that, because ComputerEyes gives you such broad control over the appearance of your images, a perfect calibration is not really all that critical. It just helps you get the most out of your ComputerEyes system.

No. Colors/Levels

This option lets you use a number of colors or intensity levels other than the default maximum (sixteen) to be used in captured images. Normally, for the best color or gray-scale rendition, you would like to use as many colors as possible. But there are certain cases where you might like to cut back. For example, you could reserve one or two colors for your own use in a graphics package like Paintworks or Deluxe Paint by setting the number of colors to 14 or 15. Or if you are capturing an image which has only a few colors to begin with, you could set the number of colors low to force those colors to be used, omitting any others. The color palette entries for all unused colors are set to black; they can, of course, be set to any other color later in the graphics package that you use.

To change the "No. Colors/Levels", click on the corresponding box and enter the number (from 2 to 16) that you would like used in the images.
that you capture. The default value for "No. Colors/Levels" is 16. If you have raw image data available, as when you have freshly captured an image or loaded a Raw Data file, and you select the "Paint From Raw Data" command, this will cause the screen to be repainted using the number of colors or intensity levels that you specified.

**Color Separation**

In addition to the "No. Colors/Levels" setting, there is another parameter under your control that affects how images are painted: "Color Separation". The "Separation" setting determines the minimum difference between any two colors chosen for the palette. This makes it possible to control the palette generation so that several palette entries aren't used up on colors that are just slightly different shades from each other. Refer to the HINTS AND TECHNIQUES Section for more detail on how to take advantage of these features. The "Separation" setting is set to two by default, which is a good choice for a wide variety of image types. If you set the "Separation" to a higher value, you will force ComputerEyes to use colors with more differences (separation). If you set it to one, smaller differences are allowed. Experiment!

To change the "Color Separation" setting, click on the corresponding box and enter the number (from 1 to 7) that you would like used in the images that you capture. If you have raw image data available, as when you have freshly captured an image or loaded a Raw Data file, and you select the "Paint From Raw Data" command, this will cause the screen to be repainted using the Color Separation that you specified.

The "Color Separation" setting has no affect on how black-and-white images are painted.

**View Full Image (OPEN-APPLE/V)**

This function is fairly self-explanatory. It allows you to quickly view the image in the currently active Window as a full-screen image. When you select it, you are immediately presented with a display of the image in the currently active Window in the Super Hi-Res 320 by 200 Graphics Mode. Click the Mouse Button or press any key to return to the ComputerEyes Desktop.
View SPECIAL... (OPEN-APPLE/W)

This command is similar to the "View Full Image" command, except that the image in the active Window is first converted to one of several supported alternative Graphics Modes. The "View SPECIAL" command allows you to convert an image that you've captured - or loaded from disk - to a different Apple graphics format. This is a very powerful feature of ComputerEyes, and one that you can use for non-ComputerEyes images, too. Essentially, you can convert images rather freely between Standard Hi-Res, Double Hi-Res, and Super Hi-Res formats (as well as Print Shop Graphics), with a minimal loss of image quality.

When you select "View SPECIAL", you are first presented with a Dialog Box from which you can select the Graphics Mode you would like to use, as shown below. To do this, click on the Radio Button associated with the desired Graphics Mode. Clicking on "Cancel" gets you back to the ComputerEyes Desktop.

View Image As:

- Super Hi-Res (B/W)
- Super Hi-Res (640 B/W)
- Double Hi-Res (Color)
- Double Hi-Res (B/W)
- Standard Hi-Res
- Print Shop Graphic

☐ Paint From Raw Data

Note that the "Raw Data" selection will only be enabled if the active Window has raw image data associated with it. This will be the case if the Window contains the last image captured with ComputerEyes or the last image loaded as "Raw Data" using the "Open SPECIAL" command, either of which result in raw image data being available to be saved.

There is a "Paint From Raw Data" Check Box at the bottom of the "View
SPECIAL" Dialog. Refer to the discussion of the Super Hi-Res (640 B/W) file type below for its meaning.

Once you've selected the desired Graphics Mode, click on "OK". The image in the active Window will be converted to the alternative Graphics Mode, and the entire screen will then be painted with the image for you to view. Clicking the Mouse Button or pressing any key will restore the ComputerEyes Desktop. Note that the image inside the Window does not change - it's always displayed in the Super Hi-Res 320 by 200 mode. "View SPECIAL" allows you to preview the appearance of an image converted to one of the alternative modes, should you choose to save it to disk using the "Save SPECIAL" command.

Because of the large number of possible Graphics Mode conversions we've provided, and also because of the differences in the characteristics of the various Graphics Modes, you can achieve some very interesting effects in just converting an image among the various Graphics Modes. When you combine this with the capabilities of the "Adjust" commands, you'll find that you have, built right into ComputerEyes, a very powerful image processing package.

The following paragraphs describe some of the characteristics of images displayed in the supported SPECIAL Graphics Modes.

Super Hi-Res (B/W) - GS Super Hi-Res Graphics Mode with resolution of 320 by 200 pixels, where each pixel can take on one of six shades of gray. This allows you to view an image originally captured or loaded from disk in color as a black-and-white image. Whatever color palette is in effect for the color image is simply replaced with one containing sixteen shades of gray. The palettes of ComputerEyes color images are always arranged in ascending order of overall intensity, so that this conversion results in a black-and-white image that is almost (but not quite) as good as if it had been captured directly as B/W 320 SUPER. Images loaded from other programs may not have their palettes arranged in ascending order, so the results may be somewhat unpredictable. Since the quality will not be quite as good as an image originally captured as a black-and-white image, and if your application is strictly black-and-white (such as desktop publishing), use the "Capture B/W" command.

Super Hi-Res (640 B/W) - GS Super Hi-Res Graphics Mode with resolution of 640 by 200 pixels, where each pixel can take on one of four different colors. This makes it inappropriate for color images, but black-and-white images can benefit from the higher resolution. Normally, the converted 640 Mode image would contain the four shades of gray; however, if you turn on "Dithering" (see the "Capture Settings" description in the "Image" Menu), the sixteen 320 Mode shades are represented
In 640 mode by "dithering" between the four available shades. "Dithering" is a technique whereby the effect of multiple intensities is achieved by displaying the separate available intensities in an alternating pattern. The degree to which you actually see the dithering depends on your monitor - some monitors will smear the individual pixels enough that the 640 image looks almost like the 320 image.

Note that, if Raw Data is currently available and you select the Super HI-Res (640 B/W) Graphics Mode, the "Paint From Raw Data" Check Box will be enabled. If you click on this box to place an "X" in it, ComputerEyes will actually paint the screen in 640 mode directly from the raw image data, rather than convert the screen from the 320 mode image. This results in an image of higher quality (especially if "Dithering" is turned on - see "Capture Settings").

Double HI-Res (Color) - Apple Graphics Mode available on the GS and on IIe and IIC computers with 128 kilobytes of memory. These images are considered as consisting of 140 by 192 pixels, where each pixel can take on one of 16 colors. The colors are pre-defined and not selectable. Because the Super HI-Res mode has better resolution and color rendition than Double HI-Res, this conversion is somewhat lossy, but is nonetheless worthwhile. Since Double HI-Res color images can contain only sixteen pre-defined colors, the Super HI-Res colors are represented in Double HI-Res by dithering between the sixteen available colors. The results are quite acceptable, and it means that you can capture color images for use with such popular Double HI-Res programs as DazzleDraw by Broderbund.

Double HI-Res (B/W) - Apple Graphics Mode available on the GS and on IIe and IIC computers with 128 kilobytes of memory. These images are considered as consisting of 560 by 192 pixels, where each pixel can be either on or off (white or black). The colors in the Super HI-Res image are first converted to sixteen shades of gray, and then are represented in Double HI-Res as dithered pixel patterns. Since Super HI-Res images are slightly larger than Double HI-Res, the converted image comes from the center of the Super HI-Res screen.

Standard HI-Res - The basic Apple Graphics Mode available in all Apple II computers. These images can be considered two ways: 280 by 192 pixels, where each pixel can be either on or off (white or black); or as color images with six colors possible, where the colors are determined in a rather complicated manner based on screen position and other factors. Because of the poor color capability of this mode, ComputerEyes only converts images to the black-and-white version. However, you can convert an existing Standard HI-Res color image to Super HI-Res Color using the "Open SPECIAL" command. Thousands of programs have
been used over the years to generate millions of color and black-and-white Standard Hi-Res Images - now you can convert them to the GS Super Hi-Res format.

Print Shop Graphic - The format used by the popular "Print Shop" program by Broderbund for graphic images. "Graphics" have a modest resolution of 88 by 52, with just 8 fixed colors. But since they are usually printed rather small, some surprisingly good results can be obtained. The original Super Hi-Res image is first blocked up into the same size pixels as in the "Graphic Editor" portion of Print Shop. Then each of these pixels is assigned one of the eight Print Shop colors closest to the original Super Hi-Res image color. Dithering is always applied to this process to help the Graphic appear as good as possible. The image is left this way on the screen for you to view. It is larger than the actual size of a Print Shop Graphic, but when you save your image to disk (see "Save SPECIAL"), you can select the portion of the image that you would like saved. When you're done, click the Mouse Button or press any key. Super Hi-Res images have resolution and color rendition that are far superior to Print Shop Graphics, so you may be a bit disappointed at first, but stick with it - Print Shop Graphics always look better printed than they do blown up on the screen.

View Video Input (OPEN-APPLE/I)

If you are using a composite monitor, either instead of or in addition to an RGB monitor, ComputerEyes gives you the ability to preview the video image that you're about to digitize right on your monitor. When this command is selected, the signal from the video source (camera, VCR, etc.) is passed directly to the monitor so that the camera may be positioned and focused on the subject, and generally so that the video can be previewed before being digitized. Clicking the Mouse Button or pressing any key will restore the ComputerEyes Desktop. You will find this feature quite useful - it saves a lot of time and guesswork, and can often reveal the cause if you're having a problem getting good images.

This command is not functional if you are using an RGB monitor, such as the GS Color Monitor. In this case, you won't be able to use the "View Video Input" feature, but all of the other features will work properly. Most color cameras have viewfinders built in that can be used for the same purpose. If you decide to connect another (composite) monitor for the purpose of viewing your video source, be sure to tell ComputerEyes by selecting "Configuration..." from the "Adjust" Menu and specifying the "Composite" monitor type.
Paint From Raw Data

This command is very powerful in that it allows you to completely repaint the screen from the original raw image data. You can, in fact, make changes to the “Dithering”, “No. Colors/Levels”, and “Color Separation” parameters (see “Capture Settings” in the “Image” Menu) as many times as you would like, as long as there is Raw Data available, and repaint the screen to see the effect of these changes.

In addition, “Paint From Raw Data” lets you go back to the image as it was originally captured (or loaded from disk as a Raw Data file) after making a number of modifications that you don’t want to save. For example, if you’ve used some of the “Adjust” commands (see below) to flip, invert, scroll, and shrink an image and you want to start over, select “Paint From Raw Data”.

If you are adjusting a color image, the system takes a few seconds after you select “Paint From Raw Data” to analyze the image to determine the color palette it will use to paint the image. It displays a message on the screen to this effect, and then paints the image into the active Window.

It is important to understand that “Paint From Raw Data” recalculates the palette and the value at every screen pixel location from a large table of raw image data created by performing a capture. This means that you can readjust the appearance of the image as many times as you want without losing the original image data. The Image is NOT rescanned (unless you select “Capture” again). This is a very powerful approach and allows you to optimize the characteristics of every image that you capture.

If you load an image from disk and it is not a Raw Data file, it can not be repainted as a freshly captured image can. This is because it is a picture file, and does not consist of raw image data as created by performing a capture. You’ll notice, in fact, that the “Paint From Raw Data” command will be disabled (grayed out) without having first either captured an image or loaded a Raw Data file. If you have several Windows on the ComputerEyes Desktop, only one of them can have Raw Data associated with it (see the “Window” Menu description), and “Paint From Raw Data” will only be enabled for that Window.
Timer (OPEN-APPLE/T)

The "Timer" command is a unique feature very much like the self-timer feature of many still cameras. If the timer is enabled and you select either of the "Capture" commands, you'll be given five seconds after you select "Capture" before the scanning actually takes place. During this time, a message appears on the screen counting down the time, and the computer beeps at one second intervals. This gives you enough time to move away from your computer and in front of the video camera, if you're operating alone and this is the type of image that you're capturing.

Selecting the "Timer" command turns the timer on if it was previously off, and vice-versa. It does not cause a Capture to take place, but rather enables or disables the timer for any subsequent Captures. If the timer is on, a Check Mark appears to the left of the "Timer" item in the "Image" Menu.
Adjust Menu

The “Adjust” Menu includes a powerful set of commands that allow you to modify the appearance of the images that you capture for a variety of special effects. If you capture a fresh image and then perform any of the “Adjust” commands, you will always be able to go back to the original image, since the raw image data is not lost. However, you should remember that, if you do repaint the screen from the Raw Data, any operations previously performed with “Adjust” will be lost.

When you select “Adjust” from the ComputerEyes Desktop, you are presented with the “Adjust” Menu that contains all of its commands, as shown below. These commands are described in the following paragraphs.

<table>
<thead>
<tr>
<th>Adjust</th>
<th>Adjust Palette</th>
<th>CA</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>High Contrast</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mirror</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Invert</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Scroll</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Shrink/Expand</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Configuration...</td>
<td></td>
</tr>
</tbody>
</table>

Adjust Palette (OPEN-APPLE/A)

The “Adjust Palette” command is a very powerful image manipulation tool - one that you’ll find yourself using all the time. With it, you can easily and quickly change the brightness and contrast of either the entire image, or of the individual colors (red, green, and blue) as well.

When you select “Adjust Palette”, you are presented with a full-screen version of the image in the currently active Window. On top of the image are a collection of six Scroll Bars, an “Adjust” title bar, and “OK” and “Cancel” buttons. Basically, you can make any adjustments to the appearance of the image that you would like using the Scroll Bars, and then click on “OK” to make them a permanent part of the image and return
to the ComputerEyes Desktop. "Cancel" returns you to the Desktop, ignoring the changes that you've made.

Extra effort was made to make this Dialog Box "see-through", so that as much of the image is viewable as possible. Also, you can drag the Dialog Box to any position on the screen by grabbing the "Adjust" title bar and dragging it, so that you can view the portion of the image that is most crucial to you.

The Scroll Bars are implemented in the standard manner. You can either drag the slider up or down to a new position, click above or below it to achieve relatively large jumps, or click on the up or down arrows to achieve small jumps. Numerical values are maintained for each Scroll Bar to help you keep track of your changes. The functions of the Scroll Bars are described below:

R - Red - (Range 0-15). Increasing the slider adds a reddish tint to the image, while decreasing it subtracts red and leaves the image with an aqua tint.

G - Green - (Range 0-15). Increasing the slider adds a greenish tint to the image, while decreasing it subtracts green and leaves the image with a violet tint.

B - Blue - (Range 0-15). Increasing the slider adds a bluish tint to the image, while decreasing it subtracts blue and leaves the image with a yellow tint.

I - Intensity - (Range 0-30). Increasing the slider adds brightness to the image, while decreasing it leaves the image darker.

C - Contrast - (Range 25-99). Increasing the slider adds contrast, and forces a greater difference between light and dark areas. Decreasing it subtracts contrast and leaves the image with more subtle differences between light and dark. (The range doesn't go below 25 to prevent you from obliterating the image totally and getting hopelessly lost.)

S - Saturation - (Range 0-99). Affects the color saturation of the image. Increasing the slider results in an image with deeper, more highly saturated colors. Decreasing it results in smaller differences between red, green, and blue and therefore more subtle colors. In fact, reducing Saturation to 0 will result in an image that is purely shades of gray.

We highly recommend that you spend some time experimenting with various combinations of "Adjust Palette" settings. You'll find that it's an easy (and fun!) way to get the most out of your ComputerEyes images.
If you are like most people, it may take a little practice before you get the feel of what the effect of changing a particular "Adjust Palette" setting might be. For example, it is not intuitive to everyone that increasing both red and green makes an image appear more yellow. It does no harm to experiment with various changes to see what the effects are. Refer to the HINTS AND TECHNIQUES Section for additional guidance.

Note that you can use the "Adjust Palette" command with ANY Super Hi-Res image—even images that you've loaded from disk. This means that you can use it to adjust the appearance of images from other sources, such as from one of the GS paint or drawing programs. The major advantage of "Adjust Palette" is that most graphics programs allow you to change the appearance of one palette color at a time; "Adjust Palette" changes the appearance of the entire palette simultaneously, which allows you to achieve an overall effect much more rapidly.

**High Contrast**

This command allows you to convert the image in the active Window, which consists of up to 16 intensity levels or colors, to an ultra-high contrast image (that is, one that consists of two intensity levels: black and white). It is useful for creating images that have high contrast to begin with, such as line drawings and clip art. Although the images have only two levels, they are still 320 mode Super Hi-Res images and can be saved to disk for use with other Super Hi-Res graphics programs.

When you select the "High Contrast" command, you are presented with a full-screen version of the image in the currently active Window, converted to high contrast (two colors). On top of the image is a Dialog Box containing a Scroll Bar and "OK" and "Cancel" buttons. You can make adjustments to the appearance of the image using the Scroll Bar, and then click on "OK" to make them permanent and return to the ComputerEyes Desktop. "Cancel" returns you to the Desktop, ignoring the changes that you’ve made. Moving the Scroll Bar essentially changes the intensity threshold above which everything is white and below which everything is black.
Mirror

The “Mirror” command causes the image in the currently active Window to be flipped left-to-right. The most common use for this is to reverse an image that is to be printed with heat-transfer ink and ironed onto fabric, a process which itself produces a reversal. When you select “Mirror”, the image is mirrored and displayed as a full-screen image for you to view. Click the Mouse Button or press any key to return to the Computer Eyes Desktop. Or you can restore the original image by pressing ESCape, or simply by selecting “Mirror” again.

Invert

The “Invert” command causes the image in the currently active Window to be inverted, or negated, or complemented. White areas will become black and vice-versa. For black-and-white images, the effect is to provide a very realistic inversion, like a photographic negative. For color images, the effect is similar but a little less apparent. When you select “Invert”, the image is inverted and displayed as a full-screen image for you to view. Click the Mouse Button or press any key to return to the Computer Eyes Desktop. Or you can restore the original image by pressing ESCape, or simply by selecting “Invert” again.

Scroll

The “Scroll” command allows you to shift the image in the currently active Window left, right, up, and/or down around the screen. Note that this is NOT the same as using the Window Scroll Bars; rather, the full-screen image is scrolled.

When you select “Scroll”, you are first asked whether you would like wraparound to occur by means of a Dialog Box containing two Radio Buttons labeled “Erase” and “Wrap”, as shown below. Wraparound means that, for example, if you are scrolling an image left, the portion of the image that is shifted off the left edge of the screen gets shifted back onto the right edge. If you don’t ask for wraparound (you select “Erase”), the right edge becomes black. You can effectively “crop” an image (eliminate top, bottom, left, and/or right borders) simply by scrolling it with “Erase” selected. Note that you can in effect make the lost edge white by INVERTing, scrolling without wraparound, and reINVERTing.
SCROLL

Use Arrow Keys To Scroll  
ESC To Cancel  
Mouse Button To Save

@ Erase   ○ Wrap

OK      Cancel

After you select the wraparound mode, click on “OK” and the image is displayed. (“Cancel” simply returns you to the ComputerEyes Desktop.) You can scroll pressing the Apple’s Left-, Right-, Up-, and Down-Arrow Keys. Click the Mouse when you’re done, and you’ll return to the ComputerEyes Desktop. Or you can restore the original image by pressing ESCape, or by scrolling them back in the opposite direction, as long as “Wrap” is selected.

Scrolling is useful for centering the portion of an image that you’re interested in before converting it to Standard or Double Hi-Res, since some of the outside edges are lost in these conversions.

Shrink/Expand

The “Shrink/Expand” command is a powerful tool that lets you reduce or enlarge the size of an existing image. It is very useful in matching up the size of your images to the requirements of the various graphics programs that you might be using. You can compensate for the slight aspect ratio distortion inherent in conversions to Standard or Double Hi-Res by shrinking or expanding slightly first, if desired. You can shrink or expand an image by any percentage (not just powers of two) independently in both the horizontal and vertical dimensions.

When you select the “Shrink/Expand” command, you’re first presented with a Dialog Box asking you for the percentages you would like to change the image in the both the horizontal and vertical dimensions. These can be any value between 10 and 1000, where 100 percent means
no change. The allowable range of percentage values means that you can make an image up to 10 times larger or 10 times smaller. In most cases, you would probably use the same percentage for both, although the ability to control them independently can sometimes be important. For example, if your printer prints images with a distorted aspect ratio, you can compensate for this exactly by choosing the appropriate percentages.

Enter the percentages, making sure that you don't click on "OK" or press RETURN until both numbers have been entered. Rather, enter the "Horizontal Percentage", click on the "Vertical percentage" box, and enter its value. After you've entered the percentages, click on "OK", and the process begins. ("Cancel" simply returns you to the ComputerEyes Desktop.) The resized image is displayed full-screen for you to view. Click the Mouse Button or press any key to return to the ComputerEyes Desktop. Or you can restore the original image by pressing ESCape.

One might think that shrinking an image by a factor of 2 (50%) and then expanding it by a factor of 2 (200%) would yield the original image, but this is not the case. This is because of the finite size of the pixels that make up the Super Hi-Res screen. The result is an image that's exactly the same size as the original, but where each pixel is individually twice its original size. You can achieve some interesting posterizing effects by experimenting with various combinations of shrink/expand percentages.

Images are always referenced to the upper left corner of the screen. Thus, when you shrink an image, the entire screen is reduced up into the left corner. Likewise, when you expand an image, the portion of the screen in the upper left corner is enlarged to fill the entire screen. For expanding, you would typically "Scroll" the image so that the portion of interest is in the upper left and then enlarge it.

Configuration...

If you should you change something about your system that might affect the operation of Color ComputerEyes, you can enter the Configuration Dialog Box by selecting "Configuration..." from the "Adjust" Pull-Down Menu. Examples of this would occur whenever you move the interface board to a different slot, or if you were to use a different type of monitor. Since you must specify your configuration information before you first run ComputerEyes, this topic is discussed in the GETTING STARTED Section.
Window Menu

The operation of the "Window" Menu is quite straightforward, but in this Section we will also go into greater detail regarding the operation of Windows in general.

When you select the "Window" Menu, you will see a list of the names of all open Windows. The currently active Window is indicated by a Check Mark to the left of its name. If a Window has Raw Data associated with it, this is indicated in that its name is displayed in a bold font. You can change the active Window by selecting it from the "Window" Menu. Of course, you can also change the active Window by clicking on it when you see it (or a portion of it) on the ComputerEyes Desktop. Sometimes, especially if you have a large number of open Windows, using the "Window" Menu can be an efficient means of making the switch.

ComputerEyes Windows fully comply with Apple's standards concerning how Windows operate. Briefly, this means that you can use a Window to scroll within the actual full-screen image using the horizontal and vertical Scroll Bars and Arrow Buttons; you can resize the Window by dragging the box in the lower right corner; you can force a Window to and from full size by clicking on the box in the upper right corner; you can move the entire Window around the screen by dragging the Title Bar; and you can close the Window by clicking on the box in the upper left corner. We don't intend here to define the operation of Apple Windows, so if this is foreign to you, please refer to your GS/OS documentation for a complete description of the Windows concept.

You may have already noticed a curious phenomenon regarding inactive Windows, in that they appear to have the wrong colors. This is a consequence of the fact that the GS can display just 16 colors on the SCREEN at one time. ComputerEyes never forgets what color palette has been selected for each of the open Windows, and so when you make any particular Window active, then its palette becomes the one used for the entire screen at the moment. As an aside, ComputerEyes always assigns color palettes in increasing order of intensity, from dark to light. This fact helps so that inactive Windows will bear recognizable images, even though the colors are actually wrong.
Several topics are included in this Section to help you get optimal results from your ComputerEyes system.

Getting Good Color

Probably the most challenging aspect of working with your ComputerEyes system is obtaining images with the most realistic color rendition. This is a result of the fact that the GS can display just 16 different colors on the screen at one time. ComputerEyes goes to extreme effort in calculating which 16 of the 4096 possible colors will be used in each color image that you capture (when you see the “Calculating Palette” message). There are steps that you can take (in particular, your control over the “Capture Settings” parameters) to help ComputerEyes make the calculations required to get you the image that you want in a given situation. We’ll go into these shortly.

A good technique, in general, in processing the images that you capture to achieve maximum quality or a special effect is as follows. Select “Capture Settings” from the “Image” Menu and set the various controls to settings that seem appropriate, based on the discussions in the “Capture Settings” description. Usually, “Auto Calibrate” should be left on (checked). Capture an image. If the camera aim or focus was wrong, or if you need to adjust lighting conditions, capture the image again. Once you have an image that’s basically correct, don’t capture any more. Next, experiment with the “Capture Settings” by making changes to the “Dithering”, “No. Colors/Levels”, and/or “Color Separation” settings as you see fit, and view the result by selecting “Paint From Raw Data” from the “Image” Menu. You can perform these two steps as many times as you would like. Finally, use the “Adjust Palette” command to make final corrections to the intensity and color
balance. With a little practice, you’ll soon be able to master the techniques that are best for you in working with the GS’s 16 available colors.

Don’t be afraid to experiment! It’s enlightening (and fun) to try making various changes to images that you capture with the wide variety of image manipulation functions included with your ComputerEyes system. Experimentation and experience will quickly allow you get the most from your ComputerEyes system.

The “Capture Settings” Options

The following are hints regarding the use of the “Capture Settings” options that affect the appearance of images that you capture. Don’t forget that you can make changes to the Capture Settings and repaint the screen with your images as many times as you would like without losing the original raw image data.

Use of the “No. Colors/Levels” and “Color Separation” Options

In addition to the easy, fast, and flexible control provided with the “Adjust Palette” command, the “No. Colors/Levels” and “Color Separation” options give you further control over the appearance of your images. You will want to experiment with all of these controls to develop a good feel for their effects. You’ll soon learn what types of control settings give you the best results with various types of images.

In general, for most image types, you want to use as many colors as possible. A person’s face, for example, consists of many subtle shades, and the more colors you have available on the screen, the better. So you would probably set the number of colors to 16, or perhaps 14 or 15 if you wanted to save one or two for your own use later (such as adding text to the image).

Other image types might require a different approach. For example, if you wanted to digitize a logo which contained, say, just three colors (e.g. red, white, and blue), it would be appropriate to set the number of colors to 3. This would force ComputerEyes to display the entire image in just three colors, which is what you want. This is also where the “Color Separation” setting comes in.

Let’s say that our red, white, and blue logo consisted of small areas of red and blue on a large white background. We set the “No. Colors/Levels” to 3 and paint the screen to see the result. What happens is that, because most of the image consists of shades close to white, our smaller red and blue areas get lost. To correct this, set the “Color Separation”
setting to a higher number. This causes ComputerEyes to ignore colors that are close to the predominant white, and skip on to colors with more differences (like red and blue). Try different settings of “Color Separation” to get the best result.

Use of the “Dithering” Option

“Dithering” is a technique in which we display the separate available colors or intensities in an image in an alternating pattern. This achieves the effect of having more colors or intensities than the 16 of which the GS is capable. The resulting images can have a smoother, more pleasing appearance. Normally (with “Dithering” off), images are displayed with up to 16 colors or gray levels. With “Dithering” on, the same colors or gray levels are used to display the image, but shades that lie between two colors or gray levels are represented by dithering between them; hence, the smoothing effect. 

For images that contain only a few distinct colors (such as our logo example above), you would probably want to leave “Dithering” off, since what you are after is an image with just a few sharply defined colors. But for most types of images (faces, scenes, and many other real-world subjects), dithering produces images with substantially enhanced color or intensity shading.

Use of the “Auto Calibrate” Option

Normally, you would want to leave the “Auto Calibrate” option always set to “On”, as this allows ComputerEyes to calculate new settings of brightness, contrast, and color content for each image that you capture. This approach compensates for varying subjects and lighting conditions. In certain circumstances, however, you can get better results by forcing ComputerEyes to calibrate on a known subject and then disabling automatic calibration, as follows:

First, make sure that “Auto Calibrate” is set to “On”. Provide a video input as close to black-and-white as possible by aiming your camera at a subject containing primarily shades of gray. The Test Pattern provided on the back page of this manual, which contains black, white, and shades of gray, works well for this. (If you are just using a VCR, try to select a black-and-white scene, such as from a black-and-white movie.) Perform a “Color Capture”, and don’t pay too much attention to the result. Then re-enter “Capture Settings” and set “Auto Calibrate” to “Off”. Images that you capture from this point on will use the calibration from the Test Pattern Image. It is like using the “White Balance” adjustment button on a color video camera.
Please note that, because ComputerEyes gives you such broad control over the appearance of your images, a perfect calibration is not really all that critical - it just helps you get the most out of your ComputerEyes system.

The "Palette" Option

Always leave the "Palette" option set to "Unfrozen", unless you have a very specific application that requires you to capture images that all use exactly the same color palette. Otherwise, ComputerEyes will force all images (even ones that are quite different from one another) to contain the same colors, which can be rather unnatural.

Lighting and Related Considerations

Just as important as the "Capture Settings" is your control over lighting and other characteristics of your video signal. Here are a few hints in this regard:

- Light the subject evenly to minimize shadows.

- Avoid fluorescent lighting - it imparts a strong greenish tint to the video signal (even though our eyes don't detect it, it's there). If you must work in a room with fluorescent lights, move the subject close to a window to get as much natural lighting as possible.

- Natural light is best, incandescent next, and fluorescent is the worst. Photographic floodlights work fine, but are definitely not required.

- Make sure that the video image has no "hot spots" which could throw off the ComputerEyes calibration, such as a bright light behind a person's head.

Use of the "Adjust Palette" Controls

Whenever you capture an image with "Auto Calibrate" on (see "Capture Settings"), the ComputerEyes software automatically adjusts the intensity (brightness and contrast) and color (red, green, and blue) content settings based on the characteristics of the input video. Very often, this will give you excellent results. However, to get special effects or to compensate for unusual lighting situations, you can then use the "Adjust
Palette* controls.

The actual mechanics of using the "Adjust Palette" command are described in the "Adjust Palette" Section. Here, we’ll concentrate on how the command can be used to greatest effect.

When you choose the Intensity slider ('I'), the meaning of intensity (brightness) is fairly obvious. Moving the slider upward makes the entire image lighter, and vice-versa. The Contrast ('C') slider, on the other hand, controls the amount of difference between dark and light in the image. Moving the control upward increases the difference and produces images with more very bright and very dark areas. Moving it downward decreases the difference and yields images with more subtle shadings.

When you choose one of the colors ('R', 'G', or 'B'), its meaning is again fairly straightforward. Moving the slider upward makes the selected color for the entire image more intense, and vice-versa. What may take a little practice will be learning the effect of combinations of slider adjustments. For example, not everyone is comfortable with the idea that increasing both red and green will yield an image that appears more yellow.

As a general rule, the best images contain small bright areas and small dark areas, with most of the screen made up of various shadings in between. Of course, the subject and the desired effect will dictate the actual optimal settings.

Resolution

The limitation to the amount of resolution attainable with ComputerEyes is primarily determined by the graphics capabilities of the Apple IIGS itself. ComputerEyes uses the GS in various Graphics Modes; in general, in each case, resolution is traded off against the number of intensity levels or colors available per pixel. The Graphics Modes supported are:

Super Hi-Res, 320 Mode, Color: 320 by 200, four bits per pixel. Each pixel can take one of sixteen palette values. The palette is chosen from 4096 possible colors based on the statistical dominance of the actual colors of the original video image.

Super Hi-Res, 320 Mode, Black-and-white: 320 by 200, four bits per pixel. Each pixel can take one of sixteen palette values. The palette is defined to be sixteen shades of gray.
Super Hi-Res, 640 Mode, Black-and-white: 640 by 200, two bits per pixel. Each pixel can take on one of four palette values. The palette is defined to be four shades of gray.

Double Hi-Res, Color Mode: 140 by 192, four bits per pixel. Each pixel can take on one of sixteen pre-defined colors. ComputerEyes can convert Super Hi-Res images to and from this format.

Double Hi-Res, Black-and-white Mode: 560 by 192, one bit per pixel (each pixel either on or off). ComputerEyes can convert Super Hi-Res images to and from this format.

Standard Hi-Res, Black-and-white Mode: 280 by 192, one bit per pixel (each pixel either on or off). ComputerEyes can convert Super Hi-Res images to and from this format.

In general, you should choose the Capture Mode and convert to an appropriate display format based on what you need in terms of resolution and for what purpose you intend to use your digitized images.

You can capture images with somewhat better resolution (i.e. less jaggedness) by setting the “Capture Speed” option in the “Capture Settings” Dialog to “Slow”. See the description in the “Capture Settings” Section.

If you are interested in acquiring monochrome images, but you are using a color video source, you will maximize the resolution in your images by taking steps to minimize the amount of color content in the video signal that you're using. This can be done by:

- Turning down the color level control on those cameras that have them
- Using subjects with little color content
- Inserting a “Video Enhancer” with “Color Killer” capability between the video source and ComputerEyes
- Using a black-and-white video camera

Also, make sure that you capture the image directly in the black-and-white mode, as opposed to capturing in color and converting to black-and-white. This causes ComputerEyes to disable the color decoding circuitry on the interface card, eliminating interference that can be caused by the presence of color.
Working With Video Tape Recorders

Moving images must be paused for the duration of the ComputerEyes scan, and so your results depend on the quality of the freeze-frame capability of your VCR. Most four- and five-head VCR’s work fine, and the “digital” VCR’s work even better; two-head VCR’s are marginal. Here are a few hints in obtaining the most stable image from any of the non-digital VCR’s:

- Use the FAST tape speed.
- Use high-quality video tape.
- Adjust the “Tracking” control for best results.
- Keep your tape heads clean.
- Some frames will “Freeze” better than others, so use “Frame Advance” to select a frame that is as free from noise and jitter as possible.

Using ComputerEyes Images In Other Programs

One of the most important considerations in using ComputerEyes concerns how to get images transferred from ComputerEyes to other programs so that you can use them in your application. You can use images captured with ComputerEyes in literally hundreds of commercially available programs for the Apple II family. The following is a list of some of the more popular programs and our recommendation for the image file format to use. This list is far from complete. If you use a graphics program not included, refer to its documentation for information on getting images into it from other programs. Or experiment! It certainly does no harm to capture an image and save it to disk using the “Save” and “Save SPECIAL” commands to see which format(s) your program will accept.

Some programs will accept more than one image file format. Generally, if there is a choice, it is better to use a Super Hi-Res format than Standard or Double Hi-Res; likewise, Double Hi-Res is better than Standard Hi-Res. Also, some programs (including Appleworks GS and Medley) will accept 320 mode images but immediately convert them to 640 mode for their own use; usually, you will get better results if you save images directly from ComputerEyes in 640 mode. Hint: you’ll generally enhance the quality of the image if you turn on “Dithering” and “Paint From Raw Data” before saving.
<table>
<thead>
<tr>
<th>Application</th>
<th>Save Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appleworks GS</td>
<td>&quot;Save SPECIAL&quot; &quot;Super Hi-Res (640 B/W)&quot;</td>
</tr>
<tr>
<td>Dazzle Draw</td>
<td>&quot;Save SPECIAL&quot; &quot;Double Hi-Res (B/W)&quot; or &quot;Double Hi-Res Color&quot; with &quot;Dazzle Draw Format&quot; checked</td>
</tr>
<tr>
<td>Deluxe Paint II</td>
<td>&quot;Save&quot; (Super Hi-Res)</td>
</tr>
<tr>
<td>Hyper Studio</td>
<td>&quot;Save SPECIAL&quot; &quot;Super Hi-Res (640 B/W)&quot;</td>
</tr>
<tr>
<td>Medley</td>
<td>&quot;Save SPECIAL&quot; &quot;Super Hi-Res (640 B/W)&quot;</td>
</tr>
<tr>
<td>Mouse Paint</td>
<td>&quot;Save SPECIAL&quot; &quot;Standard Hi-Res&quot;</td>
</tr>
<tr>
<td>Paintworks Plus/Gold</td>
<td>&quot;Save&quot; (Super Hi-Res)</td>
</tr>
<tr>
<td>Print Shop</td>
<td>&quot;Save SPECIAL&quot; &quot;Print Shop Graphic&quot;</td>
</tr>
<tr>
<td>Publish Itf</td>
<td>&quot;Save SPECIAL&quot; &quot;Double Hi-Res (B/W)&quot; with &quot;Dazzle Draw Format&quot; checked</td>
</tr>
<tr>
<td>Springboard Publisher</td>
<td>&quot;Save SPECIAL&quot; &quot;Standard Hi-Res&quot;</td>
</tr>
<tr>
<td>Tutor Tech</td>
<td>&quot;Save SPECIAL&quot; &quot;Double Hi-Res (B/W)&quot; with &quot;Dazzle Draw Format&quot; checked</td>
</tr>
<tr>
<td>VCR Companion</td>
<td>&quot;Save SPECIAL&quot; &quot;Double Hi-Res (B/W)&quot; with &quot;Dazzle Draw Format&quot; checked</td>
</tr>
<tr>
<td>816/Paint</td>
<td>&quot;Save&quot; (Super Hi-Res)</td>
</tr>
</tbody>
</table>
The purpose of this Section is to acquaint you with the principles behind the operation of ComputerEyes. You may have absolutely no interest in the actual innerworkings of ComputerEyes, and that's fine - just skip this Section entirely.

Although gate-level and line-of-code-level analyses are beyond the scope of this manual, the material included here is necessarily somewhat technical. Readers not familiar with the nature of video signals will have difficulty understanding the information presented. It is important to note that it is not necessary to understand any of the information provided here in order to fully utilize the system.

**General Operation**

ComputerEyes is a system consisting of a carefully planned combination of hardware and software; neither has any worth without the other. The system performs a slow scan on the video signal present at the ComputerEyes video input connector. During every vertical scan period, the system takes in 200 samples, or one for each of the Apple IIGS's Super Hi-Res graphics rows. Thus, one column of pixels are stored every vertical scan, or 16.6 milliseconds. The point in time during each horizontal scan period that the samples are taken is delayed from the horizontal sync by an amount that is very slowly increased as the ComputerEyes scan progresses. The result is that successive columns of pixels are acquired, beginning with a short delay from the horizontal sync (left side of image) to a long delay (right side). Since 320 columns must be acquired (for 320 mode images), a complete ComputerEyes scan requires $320 \times 16.6$ milliseconds plus about one second of set-up time, or around six seconds. When the "Capture Speed" is set to "Slow", the ComputerEyes scan is slowed by a factor of two to allow bringing in twice as many samples.
A video sample consists of three analog voltages that represent the intensity values of the red, green, and blue components at a particular point in the video image. These voltages are multiplexed into a 6-bit analog-to-digital converter, the output of which is read by the Apple IIGS. The software stores these raw image data values away in memory during the progress of a scan. It then maps the values to the Apple IIGS's graphics memory based on what type of image is being displayed.

**ComputerEyes Hardware**

The ComputerEyes hardware consists of a single printed circuit board that plugs into one of the GS's I/O expansion slots. This board contains the circuitry required to perform the slow-scan image acquisition. Software running in the GS (see below) controls the acquisition of an image in the following manner. A signal is sent to the board to initiate a ComputerEyes scan. The hardware then produces a delay from each horizontal sync pulse that increases slowly during the six-second scan. At the end of the delay, the levels of the R, G, and B components of the video signal are sampled and stored in sample-and-hold circuits. These levels are multiplexed into a single 6-bit A/D converter under the control of the software. The A/D outputs and the composite sync signal are sent back to the GS. It is the software's task to detect the sync, read in the three A/D values, and to manipulate the appropriate pixel position in the GS's graphics memory.

**ComputerEyes Software**

The heart of the ComputerEyes software is a Machine Language program that starts a ComputerEyes scan and then gathers the data transmitted by the ComputerEyes Board. After a scan is initiated, the program waits a predetermined number of vertical syncs so that the image is centered left-to-right and then acquires data. After each vertical sync, a predetermined number of horizontal syncs are awaited so that the image is centered top-to-bottom. Then, a very tight loop is entered wherein horizontal sync is detected and one RGB video sample is taken in. This is done by controlling the RGB multiplexer feeding the A/D converter, and starting and reading the A/D's outputs three times. This continues for the 200 pixels in each column. The process is repeated for each of the 320 columns. Raw RGB data for the entire image is stored in a large array in the GS's memory for further processing.
After a scan is complete, or when the user selects a function that results in the screen being repainted from the Raw Data, the ComputerEyes software analyzes the raw image data array to produce the displayed image. For monochrome scans, the GS's color palette is preset to a fixed set of gray tones. For each pixel, the appropriate location in graphics memory is calculated and is set to the appropriate palette value depending on the value of the combined RGB sample.

For color images, the processing is much more complex. Because the GS is capable of displaying only 16 colors at one time (although from a repertoire of 4096 colors), considerable effort is put into determining which 16 to use. This is done by first scanning the entire raw image data array to determine the 16 most predominant colors in the image. These become the color palette. Then, the Raw Data array is processed a second time, and every screen location's actual RGB value is compared with those of the palette and a best match is found. All of this processing consumes the few seconds when the "Calculating Palette" message is being displayed.

ComputerEyes Raw Data File Format

This Section describes the format of files saved by ComputerEyes in the Raw Data Format. These files may be used by other software for purposes such as numeric Image analysis and conversion of images to alternate display types.

Raw Data files have a size of 192,256 bytes. Of these, the first 192,000 are used for image data; the remaining 256 bytes contain the ComputerEyes "Capture Settings" information. Since the "Capture Settings" information is for the internal use of ComputerEyes, just the format of the actual image data is described here.

The 192,000 bytes of raw image data represent an image resolution of 320 pixels horizontally by 200 pixels vertically by three colors (320 x 200 x 3 = 192,000). The image is stored as 64,000 bytes of red, followed by an equal amount of green data, and then blue. The first byte of red corresponds with the first byte of green and the first byte of blue to constitute a single Red/Green/Blue pixel description, and so on.

Each byte represents the color component of a single pixel. The six Least Significant Bits are the value of the pixel's intensity of the particular color, where 0 is minimum, 63 is maximum, and the numbers in between represent shades between minimum and maximum. The two Most Significant Bits are not used and are set to zero.

page 61
The pixel values are stored first in vertical columns of 200 bytes each, and then proceeding from left to right across the 320 columns of the image. Thus Byte 0 is the upper left pixel, Byte 199 is the lower left, Byte 200 is in the top row just to the right of Byte 0, and so on. The following illustrates the pixel layout for each of the three 64,000-byte color arrays:

<table>
<thead>
<tr>
<th>ROW</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>319</th>
<th>320</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>200</td>
<td>400</td>
<td>63600</td>
<td>63800</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>201</td>
<td>401</td>
<td>63601</td>
<td>63801</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>202</td>
<td>402</td>
<td>63602</td>
<td>63802</td>
</tr>
<tr>
<td>199</td>
<td>198</td>
<td>398</td>
<td>598</td>
<td>63798</td>
<td>63998</td>
</tr>
<tr>
<td>200</td>
<td>199</td>
<td>399</td>
<td>599</td>
<td>63799</td>
<td>63999</td>
</tr>
</tbody>
</table>

page 62
In Case of Difficulty

If, at any point, you experience difficulty with the operation of any aspect of the Color ComputerEyes system, please refer to this Section for help. In most instances, the problem can be identified to have a very simple cause, and can be easily remedied. In fact, the least frequently occurring problem is a defect in the Color ComputerEyes system itself. The trouble-shooting information is presented in an easy-to-follow outline format. To use it, first locate the type of problem you are having by major heading (Roman numerals). Then follow the steps in the subtopics to either resolve or isolate the cause of the problem.

I. Disk Won't Boot
   A. If other disks boot properly:
      1. If this disk is a copy of the original System Software disk, make another copy and try booting that.
      2. If this disk is a fresh copy, try booting the System Software disk.
      3. If this disk is the System Software disk, the disk has been destroyed. For a replacement, send the original System Software disk plus $15.00 replacement/handling fee to the address on the back cover of this manual.
   B. If other disks also do not boot, a problem with your Apple system must be resolved. Look in the following areas:
      1. Disk interface card (if present) not seated properly
      2. Disk drive cable not seated properly or defective
      3. Disk speed out of adjustment
      4. Defective disk drive. If you have two drives, swap their cables (with the power off) to isolate the problem.

II. "Cannot Find Card" When "Eyes" Program Is Launched
   A. Color ComputerEyes board not installed in same slot as you specified during configuration. Select "Configuration" from the "Adjust" menu, and then enter the correct slot number.
B. GS "Control Panel - Slots" not set correctly for the slot you’re using for ComputerEyes. Note that “Your Card” is not the correct setting for some slots - refer to the INSTALLATION Section for the correct setting.
C. Possible Color ComputerEyes Board failure - see Part VIII.

III. UNABLE TO "VIEW VIDEO INPUT"
A. You must be using a composite monitor (and not an RGB monitor)
B. Cable labeled “C” must be plugged into Video Out jack at rear of Apple; cable labeled “M” must be plugged into Video In jack on monitor
C. Check for lack of good video source; power not on, bad cable, etc.
D. Possible Color ComputerEyes Board failure - see Part VIII.

IV. CAPTURE COMMAND GIVES "NO VIDEO SIGNAL DETECTED" MESSAGE
A. Color ComputerEyes board not installed in Apple properly. Check that board is seated firmly, cables attached correctly.
B. No video source at Video Input connector. Check that:
   1. Video cable is inserted firmly at both ends.
   2. Video source is powered (camera, VCR, etc. plugged in and turned on).
C. From VCR, input signal must come from Video Out, not RF Out, connector
D. Incompatible video signal - video source does not conform with NTSC composite video standard. Consult manual and/or manufacturer of source.
E. Possible Color ComputerEyes Board failure - see Part VIII.

V. NO IMAGE (ALL BLACK)
A. Use the “Adjust Palette” command to increase the brightness and contrast of the captured image. If screen is not all or mostly white, then possible ComputerEyes Board failure - see Part VIII.
B. If screen is white, adjust the brightness downward until image appears.
C. If no image, see Part VII.

VI. NO IMAGE (ALL WHITE)
A. Use the “Adjust Palette” command to decrease the brightness and contrast of the captured image. If screen is not all or mostly black, then possible ComputerEyes Board failure - see Part VIII.
B. If screen is black, adjust the brightness upward until image appears.
C. If no image, see Part VII.

VII. ALL WHITE & ALL BLACK ATTAINABLE, BUT POOR OR NO IMAGE
A. Video Input far too light or too dark.
B. Video Input quite out of focus (camera only).
C. Video Input is changing too rapidly - the image must be relatively stationary for six seconds.
D. “Capture Settings” not adjusted properly - make sure “Auto Calibrate” is set to “On”.
E. If using a pre-recorded video tape in a VCR, freeze-frame (pause) quality not adequate. This can result in vertical streaking.
G. Possible ComputerEyes Board failure - see Part VIII.

VIII. POSSIBLE COMPUTEREYES BOARD FAILURE
A. If none of the remedies described above provides a solution to your problem, it is possible that the ComputerEyes Board has failed.
B. Visually examine the ComputerEyes board and cables for signs of damage.
C. Write Digital Vision Customer Service at the address on the back cover of this manual or call between the hours of 9:00 and 5:00 P.M. Eastern Time. A representative will be available to either give you assistance with your problem, or to give you a Return Authorization (RA) number. No goods will be accepted for warranty repair without an RA number assigned. Explain the nature of your problem and any evidence of damage you may have found.
D. If you are returning your unit for repair, pack it carefully (the original shipping container is excellent for this). Send the package prepaid and insured via UPS or US Mail to Digital Vision Customer Service at the address on the back cover of this manual. Digital Vision will repair or replace the unit and return it prepaid within five working days. For units not under warranty, or where the warranty has been voided, a flat fee of $50.00 must be paid before the unit can be returned.
Product: Color ComputerEyes Video Acquisition System

Type: Limited Warranty

Warranty: This Digital Vision product warranty extends to the original purchaser.

Warranty coverage performance: Digital Vision, Inc. warrants this product against defects in material or workmanship as follows:

Parts - New or comparable rebuilt parts in exchange for defective parts one year after original purchase.

Labor: Service - Carry-in service or delivery of the product prepaid insured to an authorized Digital Vision service facility or to the factory one year after original purchase.

We suggest that you retain the dealer's dated bill of sale or Digital Vision invoice as evidence of the date of purchase.

THIS WARRANTY IS VOID IF THE PRODUCT HAS BEEN DAMAGED BY ACCIDENT OR UNREASONABLE USE, ALTERATION, NEGLECT, IMPROPER SERVICE OR OTHER CAUSES NOT ARISING OUT OF DEFECTS IN MATERIAL OR WORKMANSHIP, OR IF THE SERIAL NUMBER HAS BEEN ALTERED OR DEFACED.

Warranty Disclaimers: Digital Vision, Inc. makes no warranties, either express or implied, with respect to this manual or with respect to the product described in this manual, its performance, merchantability, or fitness for any particular purpose. In no event will Digital Vision, Inc. be liable for direct, indirect, incidental, or consequential damages resulting from any defect in the product.
Digital Vision, Inc. shall not be liable for any incidental or consequential damages for breach of any express or implied warranty on this product.

Some states do not allow the exclusion or limitation of implied warranties or consequential damages, so the above limitations or exclusions may not apply to you. This warranty gives you specific legal rights, and you may also have other rights that vary from state to state.

Apple Computer Warranty Disclaimer:

GS/OS is a copyrighted program by Apple Computer, Inc. licensed to Digital Vision, Inc. to distribute for use only in combination with Color ComputerEyes. Apple Software shall not be copied onto another diskette (except for archive purposes) or into memory unless as part of the execution of Color ComputerEyes. When Color ComputerEyes has completed execution Apple software shall not be used by any other program.

APPLE COMPUTER, INC. MAKES NO WARRANTIES, EITHER EXPRESS OR IMPLIED, REGARDING THE ENCLODED COMPUTER SOFTWARE PACKAGE, ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.
Digital Vision, Inc.

270 Bridge Street

Dedham, MA  02026

(617) 329-5400